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Introduction
Many CNC (computer numeric control) tools use G-code, a set of text commands, to describe the 
sequence of movements necessary to fabricate a part.  This document provides step-by-step 
instructions to generate G-code for the ESI 5330 starting with a SolidWorks part.  

File Setup

In order to import a SolidWorks part into SmartCAMv15 the file should be a 2D drawing in .dxf 
format with dimensions in millimeters.

To do this, follow the following steps:
1. Open the desired part file in SolidWorks
2. Ensure the desired view is displayed (Top, Right, Front,…).
3. Select “File” then “Make Drawing from Part”
4. In the “Sheet Format/Size” dialog box, uncheck “Display sheet format” and click “OK”
5. Left click “Model View” in the “View Layout” tab near the top left corner.
6. Verify that the desired document is highlighted in the “Part/Assembly to Insert” box of the 

“Model View” panel.
7. Left click the “next” arrow in the top right of the “Model View” panel.
8. Ensure that a”1:1” scale is selected in the “Scale” box of the “Model View” panel.
9. Hover the mouse over the sheet in the center of the window and left click to place the drawing 

onto the sheet.  Hit “escape” on the keyboard to exit “Model View”.  If the drawing is not the  
desired view, complete the following steps:

a. Hover the mouse over the drawing to make the dashed perimeter visible.
b. Left click on the perimeter.
c. Select the desired orientation from “Orientation” box of the “Drawing View9” panel.
d. Left click on the sheet to accept the changes.

10. Save the drawing in the .dxf format by selecting “File” then “Save As”, choosing “Dxf” from 
the drop down “Save as type:” menu and clicking “Save”.

11. Close the SolidWorks.  Click “No” when prompted to save changes to the drawing unless you 
also want to save a .dwg file type of the drawing.

Importing the File into SmartCAM Advanced Fabrication v15 

Once the SolidWorks file is in the .dxf format it can be imported into SmartCAM Advanced 
Fabrication v15.  

1. Open the Advanced Fabrication v15 application.  If you cannot locate the shortcut using the 
“Start” button try the following path
“C:\Program Files (x86)\SmartCAM\SmartCAMv15\SYSTEM\afab.exe”

2. Go to the “File” menu and select “Import”. 
3. In the “Import” dialog box specify the file location in the “From File” text box.  You can also 

browse to find a file location by left clicking “File Select…”  Be sure to specify the file type as 
“DXF” in the “File Type” field.

4. Left click “Accept” to import the dxf.
5. Go to “View” menu and select “Full” to find your imported drawing.



SmartCAM AdvancedFabrication.v15
Saving a .pm5 File in SmartCAMv15

The .pm5 file you are creating is a type unique to SmartCAMv15.  It is the repository for the 
information needed to write the final G-code text file.

1. Save the file as a .pm5 by selecting the “File” menu and “Save As”.  Specify the desired file 
name and location.

Moving a Part to the Origin

The location of each element is referenced from the origin you specify.  You should select a point 
on your drawing to be at the origin.  This is typically a point in the lower left corner of the drawing.

1. Select “Transform” on the far right panel and select “Move” from the list of toolbox options 
that appears below.  The transform dialog box will open in the bottom of the Advanced 
Fabrication window.

2. Click the “+ +” button on the Group toolbar to activate all elements.  Active elements are 
displayed with dashed lines. The Group toolbar is a long, thin, vertical menu with 22 icons.  It  
can be moved independently of the main window.  If the Group toolbar is not on the screen, left  
click the icon that looks like two square boxes stack on top of each other found near the bottom 
right corner of the Advanced Fabrication window. 

3. With all elements of the part activated, select the point on your drawing you want to occur at the 
origin as the “From Point”.  You might have to select the X, Y and Z points independently from 
the same location.  Select the “To 0” option as the “To Point”.  If you are referencing the part to  
a point other than the origin select that point for the “To Point.” 

4. Go to “View” menu and select “Full” to find your imported drawing.
5. Save your .pm5 file. 

Scaling the Part

The ESI 5330 describes a tool path in microns.  The elements of the drawing currently are 
expressed in millimeters and must now be scaled by 1000 in order to transform them from 
millimeters to microns. 

1. With all elements active, select “Transform” in the right panel and “Scale” from the list of 
toolbox options that appears below.

2. Enter the value of 1000 in each of the X, Y, and Z “Scale Factor” fields.
3. Enter the value of 0 in each of the X, Y, and Z “Reference Point” fields.
4. Click on “Go” to scale the drawing.
5. Go to “View” menu and select “Full” to find your imported drawing.  If you cannot see all of 

your drawing, complete the following steps.
a. Go to “View” menu and select “Zoom”
b. Notice the “Zoom” dialog box displaying a magnification factor of 0.5.
c. Hit “Enter” to accept the magnification factor or edit as desired.
d. Left click near the center of your drawing.
e. Repeat as necessary.



6. Verify the correct scale by measuring the location of a point on your drawing.  Go to “Utility” 
menu and select “Measure”.  The cursor will be flashing in the “Point 1: X” field of the 
“Measure” dialog box.  Find a point on your drawing for which you know the XY coordinates. 
An exact point will be indicated when the large crosshair collapses into a small crosshair.  Left 
click on the point and hit “Tab” to display the X coordinate of the point.  Repeat to display the 
Y coordinate.  If these coordinates do not agree with the expected location (in microns), 
calculate the necessary scale factor and repeat Steps 1-6.

7. Save your .pm5 file. 

Creating a Tool Path 

Before a tool path can be created a job file (.jof) must be loaded.  

1. From the top of the Advanced Fabrication window, select “File” then “Load Job File”.  Select 
“v15.jof” found in the ”C:\SmartCam Files” directory.

2. Ensure that all the features you wish to be cut by the tool are selected.  You can do this by 
clicking on the “+ +” button on the group toolbar.

3. Go to “Edit” menu, “Property Chg” and select “Toolpath”.  On the far right of the Advanced 
Fabrication window near the middle, select the “6:Lsr Cut” tool from the “STEPS” list on the 
far right.  The other cutting tools listed are for other pieces of equipment.

4. Left click “Accept” in the “Toolpath Property Change” dialog box.
5. Save your .pm5 file. 

Deleting Elements

You might not wish to cut all the elements in your drawing.  They should be deleted.  

1. Select “Geo Edit” in the right panel and “Delete” from the list of toolbox options that appears 
below.

2. Left click on or near an element.  The element will disappear from view.   The “ELEMENTS” 
list on the far right will be updated to show its removal.  There is an “undo” button near the  
middle of the main toolbar.  It is a blue arrow curving to the left.  It can only be used to undo a  
single step.

3. Save your .pm5 file when done editing.

Changing the Cutting Order

To specify the sequence in which the laser cuts the elements of your part, you must change the 
cutting order.  The outside of the part should be cut last to ensure the part does not shift during the 
cutting process.

1. Select “Order Path” from the right panel, and “Seq Move” from the list of toolbox options that 
appears below.



SmartCAM AdvancedFabrication.v15
2. Left click the “ - - ” button on the group bar to deselect all elements.  Deselected elements are 

drawn with solid lines. 
3. Left click the pointer icon in upper left of the Group toolbar.  Click on individual elements in 

the order you wish them to be cut.  You can also left click and drag to select a group of features.  
After all elements are selected in the order in which you want them to be cut, select the “By 
Group Selection Sequence” in the open dialog box at the bottom of the screen.  Left click 
“Go”.  The “ELEMENTS” now shows the updated sequence.

4. Save your .pm5 file.

Creating the G-Code

The G-code can now be written.  This will result in a text file containing line-by-line instructions 
describing the toolpath for your part for written specifically for the ESI5330.

1. Select the “Process” menu and “Code”.
2. In the “Code” dialog box, left click “File Select” to open the “Save As” dialog box.  Enter the 

name the G-code file to be written and select the directory it is to be saved in. Left click “Save” 
to exit the ‘Save As” dialog box.

3. Select “Choose” to open “Job Information” dialog box.  With the “Machine File” text box 
highlighted, select “File Select”.  Double click on “V15.smf”.  With the “Template File” text 
box highlighted, select “File Select”.  Double click on “V15.cgt”.  The “Machine File” and 
“Template File” text boxes should now be updated.  Click “Accept” to close the “Job 
Information” dialog box.

4. In the “Code” dialog box, set the “Speed” to 9, “Show Tool” to “Draw End”.  Also ensure the 
“Code =” is checked and the “Show Path” is unchecked.  Each of these options serves to 
minimize the time it takes to write the code.

5. Click “Start” to start writing the G-code.   The code is actively displayed to the right of “Code 
=”.  When the coding is done, the displayed code will no longer change and the “Start” button 
will no longer be grayed out.

6. Save your .pm5 file. 

Viewing and Editing the G-Code

The G-code can now be viewed and edited using a text editor such as Notepad.   Editing is not 
required but it does offer the user greater process control. 

1. Right click on the Windows “Start” button and left click on “Explore”.  Navigate to where you 
saved your G-code.  Your G-code file will not have a specific file extension such as “.txt”, 
“.pm5”, or “.jof”.

2. Double click on the file name and left click “Open” in the “Open File” dialog box.
3. Double click on “Notepad” in the “Open With” dialog box.
4. Your G-code should now be displayed.  Below are the definitions of the characters you see.

a. “%” marks the beginning of the toolpath file.
b. “(ESI 4420)” is a remark statement giving the name of the wrong tool, doh!  You can 

create your own remark statements using all lower case letters because “G, T, P, X, Y, I, 
J and M” can all be used in commands.



c. “T1 6” specifies the tool type as ROUT.  This is a specific name and should not be 
edited.

d. “T0 221” specifies the tool name as 221.  This is an arbitrary name and can be edited. 
(See application manual.)

e. “G0” tells the tool to move at maximum speed.
f. “P0” turns the laser on.
g. “X####.##” specifies the x-coordinate to move to.
h. “Y####.##” specifies the y-coordinate to move to.
i. “G1” tells the tool to move at the speed commanded in the tool definition.
j. “G2” and “G3” tell the tool to move in an arc. (See application manual.)
k. “P1” turns the laser off.
l. “%” marks the end of the toolpath file.
m. There is also usually some junk like “90.0 = 0” that can be deleted or not.
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5. Two sets of example G-code are shown below.  Both cut two squares with sides 1mm in length. 

The first square has its bottom left corner at the origin.  The second square has its bottom left 
corner 2mm to the right of the origin.  Notice that the only difference between the two examples 
is the number of “P0” and “P1” commands:  Example A contains two pairs; Example B contains 
only one pair.

Example A
%
(ESI4420)
T1 6
T0 221
G0
P0

X0.0   Y0.0
G1 X1000.0

Y1000.0
X0.0
Y0.0

P1
P0

X2000.0   Y0.0
G1 X3000.0

Y1000.0
X2000.0
Y0.0

P1
%

Example B
%
(ESI4420)
T1 6
T0 221
G0
P0

X0.0   Y0.0
G1 X1000.0

Y1000.0
X0.0
Y0.0

X2000.0   Y0.0
G1 X3000.0

Y1000.0
X2000.0
Y0.0

P1
%

Let’s assume the actual process requires each feature to be cut three times.  The “P0…P1” 
brackets will dictate the sequence of cuts as shown below.

Example A
first square
first square
first square
second square
second square
second square

Example B
first square
second square
first square
second square
first square
second square

Example A is the default form in which SmartCam writes code but has greater potential for 
thermal effects such as melting and warping.  Example B is only achieved through manual 
editing of the code and usually achieves more desirable results.    



6. The “Replace” function in Notepad is handy when deleting repeated instances of unwanted text.
a. Select “Replace” from the “Edit” menu item of Notepad.
b. Enter the text to be deleted, such as “P0”, into the “Find what:” text box.
c. Left click on “Replace All” to delete all instances of the text.
d. Repeat steps b and c as necessary.
e. Be sure to replace all desired instances of “P0” and “P1”.

7. Save your updated G-code file.

Transferring the G-Code to the ESI5330

Past efforts to network the ESI5330 have resulted in tool instability.  We currently rely on file 
transfer via 3.5” floppy.  Yep, 20th century technology at its finest.

1. Check that your Design Studio PC has an external floppy drive plugged into a USB port.  If it is 
missing, you might find one attached to one of the other two PCs.

2. Insert a floppy disk.  There should be plenty around the Design Studio cubicles.
3. Transfer your G-code file to the floppy by a method of your choosing.
4. Ensure that the name of the file on the floppy has the following characteristics:

a. Contains no more than eight characters.
b. Contains no spaces

5. Eject the floppy disk with a great sense of satisfaction and embark on your journey down the 
stairs to the tool.


